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What Is Program Manager?
Program Manager is central to Windows. When you start Windows, the Program Manager window is 
open on the desktop like this:

Program Manager stays open in a window or as an application icon throughout your Windows session. 
When you want to exit Windows, you must do so from Program Manager.
With Program Manager you can:

Create and delete groups.
Change a group's contents.

Arrange groups and 
icons.

Change properties for 
groups and items.

Start applications.

End your Windows 
session.

Related Concepts



Concepts
Arrangement of Windows and Icons
Group Contents
New Groups
Properties for Groups and Items
Ways to Start Applications
When You Exit Program Manager



program item icon          

Starts an application when you double-click it. Program item icons are unique to Program Manager. 
Windows comes with program item icons for applications you can start from the Main, Accessories, and 
Games groups.
You can create program item icons for other applications on your hard disk. All you have to do is provide 
the location and filename for the new application. You can also include the name of a document so that it
opens when you choose the program item icon.



group window
Contains program item icons. Group windows are found only in Program Manager. Using groups, you 
can organize your applications and documents into the right combinations for the way you work.
Program Manager groups are always available either in windows or as icons at the bottom of the 
Program Manager workspace. They don't close like other windows. Instead, when you choose Close 
from the Program Manager Control menu, group windows shrink to group icons like this:



group icon
Represents group windows you have closed or minimized. Group icons all look the same. Only their 
names distinguish them from one another.
When you want to start an application (by double-clicking its icon), you must first restore the group icon 
to a window. The Main group icon opens like this:



Group Contents
Groups contain program item icons, each representing an application that you can run in Windows. You 
can also create program item icons that start an application and, at the same time, open a related 
document.

You can customize existing groups in these ways:
Add new program items.
Copy and move existing program items.
Delete program items.

Or you can create new groups of your own.
Related Concepts



Concepts
How You Add Items
How You Copy and Move Items
New Groups
What Happens When You Delete an Item



New Groups
You received three predefined groups with Windows. Click their names to learn what they contain:

Main group
Accessories group
Games group

By creating new groups in Program Manager, you can organize applications and documents to suit your 
way of working.
Click        to see some sample groups.
When you no longer need a group, you can delete it. Deleting a group removes its program item icons 
from Program Manager. The applications remain on your hard disk.

Related Procedures



Procedures
Creating Groups
Deleting Groups



Main group

The Main group contains applications that can help you configure your system, start applications, and 
manage your files and directories.



Accessories group

The Accessories group contains business applications and desktop accessories.



Games group

The Games group contains games you can play for fun and use to practice your Windows skills.



Suppose you produce a monthly newsletter, a report on several business units, and a weekly schedule 
for your division. You could create three separate groups: Report, Schedule, and Newsletter.



How You Add Groups
Although Program Manager comes with a few groups already defined, you can create your own groups 
to help you organize your applications and documents in a way that makes sense to you. For example, 
you might create a group to hold your word processor and documents for a project you are working on. 
You can add a new group by choosing the New command from Program Manager’s File menu.
After creating a new group, you can add the program items that you want included in the group.

Related Procedures



Procedures
Adding Items to a Group
Creating Groups



How You Add Items
Suppose you created a group for the applications you use to produce a newsletter, and you want to add 
a new graphics package to it. After installing the software on your hard disk, you can add the new item in
one of these ways:

Choose New from Program Manager’s File menu. You can include the name and location for a 
document when you add program items in this way. 

Click        to see program items that open documents when they start.
Drag the program file (or document file) from File Manager.

Click        to see how this works.
Use Windows Setup.

Setup searches the disk drive you indicate and adds program items for the applications you select to 
Program Manager. New items are placed in a Windows Applications group or a Non-Windows 
Applications group only.

Related Procedures



Procedures
Adding Items to a Group
Setting Up Applications



Suppose you keep monthly status reports for three separate divisions in your company. You might set up
a group that contains program items like these:

Each document you include uses the same icon as the application. Their names distinguish the items 
from one another.



File Manager can display all the directories and files on any disk drive. Suppose you want to drag the 
new program file for the new application from its File Manager directory into the Program Manager group
for your newsletter. It would look like this:



How You Copy and Move Items
You can copy and move program items by dragging them from one group window to another group 
window, like this:

An image of the item moves as you drag it with your mouse.
If you copy the item, the original stays in the source group as you move the duplicate to its destination. If
you move the item, the item is removed from the source as you place it in the destination.
You can copy or move an item to another group even if that group window isn't open, by dragging the 
item to the group icon.

Related Procedure



What Happens When You Delete an Item
You can change the contents of a group by deleting existing program items. When you delete a program
item, its icon and startup instructions are removed from the group, but the original program file remains 
on your hard disk.
If you delete a program item, you can still start its application in these ways:

With the Run command in Program Manager and File Manager
With Windows File Manager program files and document files
With a command from the Windows DOS Prompt (if it's a non-Windows application)
Related Procedures



Procedures
Deleting Items from Groups
Starting Applications from Groups
Starting Applications with the Run Command
Starting a Non-Windows Application from the DOS Prompt



Properties for Groups and Items
Properties define certain elements of a program item or group, such as the startup instructions for 
running an application. By changing properties you can revise the following elements for an existing 
group or program item:

The description of a group or program item
The description is the name of the group or program item. You might want to shorten it or rename it.

The program filename and location
The program filename and path locate the application on your hard disk. If you move the program to 
another directory or install a new version, you might need to change this property.

The document filename and location
The program filename and path locate the application on your hard disk. If you move the program to 
another directory or install a new version, you might need to change this property.

The icon for a program item
Some applications have a variety of icons you can use to represent them in the group window. If you 
choose the Change Icon button you can cycle through the offerings.



Arrangement of Windows and Icons
As you open group windows, they overlap one another like this:

Commands on the Window menu let you rearrange overlapping windows so that you can see part or all 
of each window.

Choosing Cascade resizes and rearranges the open windows, so you can see each title bar.
Click        to see an example of cascading windows.

Choosing Tile divides the workspace into space for windows of similar size.
Click        to see an example of tiled windows.

You can also manually resize and reposition the group windows.
Scroll bars appear when the resized windows are too small for all the program item icons to fit.
After resizing group windows, you might need to rearrange the program item icons so that they are all 
visible in the new window size.
Click        to see an example of arranged icons.

Related Procedures



Procedures
Arranging Group Windows
Arranging Icons
Changing a Window's Size
Moving Windows, Icons, or Dialog Boxes



cascading windows

You can also use your mouse (or your keyboard and the window's Control-menu commands) to resize 
and move each group window individually.



tiled windows

You can also use your mouse (or your keyboard and the window's Control-menu commands) to resize 
and move each group window individually.



arranged icons

You can also use the Arrange and Auto Arrange commands to rearrange program item icons after 
manually resizing a group window.



Ways to Start Applications
Double-clicking a program item icon is the easiest and fastest way to start your application.
You can also start applications in Program Manager in these three ways:

By selecting a program item icon and choosing Open from the File menu.
By choosing the Run command from the File menu. You type the startup instructions as you 

would if you were starting an application from the DOS prompt.
By choosing the DOS Prompt icon and typing a command to start a non-Windows application.

When you start an application, Program Manager changes the current directory. The directory that 
contains the application becomes the current directory.
Application windows overlap one another as you start them. Most applications cover all or part of 
Program Manager when they start.
Click        to see two application windows open on the desktop.

Related Procedures



Procedures
Starting Applications from Groups
Starting Applications with the Run Command
Starting a Non-Windows Application from the DOS Prompt



You can minimize Program Manager to an icon to keep it visible on your desktop as you work with other 
applications.



When You Exit Program Manager
When you close Program Manager, you also exit Windows. When you do decide to quit, you'll see this 
dialog box:

As you work with Program Manager, you will probably change the contents and positions of group 
windows and icons. If you select the Save Changes check box when you exit Program Manager, 
Windows will save the Program Manager workspace so that it looks just the same the next time you start
Windows.

Related Procedure













New Command

Adds a new program item to a group or creates a new group.
When you choose New, a dialog box appears so you can indicate whether you want to create a new 
group or add a new program item. After you create a new group, you can add program items. You can 
also add program items to an existing group.
Adding more than 40 program items to a group is not recommended.

Related Procedures



Procedures
Adding Items to a Group
Creating Groups



Open Command

Starts an application, opens a document, or restores a group icon to a window.
If a group icon is selected, Open restores it to a window.
If a program item icon is selected and the item is an application, Open starts the application.
If the program item icon includes a document, Open starts the application and opens the 

document.
Related Procedures



Procedures
Opening Group Windows
Starting Applications from a Goup



Move Command

Moves a program item from one group into another.
You can move a program item into a group whether it's open as a window or appears as a group icon. 
The item is removed from the source group and added to the destination group.
You can also move program items by dragging their icons with your mouse or by using your keyboard.

Related Procedure



Copy Command

Copies a program item into another group.
This command lets you use your keyboard to copy items. 
You can copy a program item into a group whether it is open in a window or appears as a group icon. A 
duplicate of the item is added to the destination group.
You can also copy a program item by holding down the CTRL key while you drag the item with your 
mouse or by using your keyboard.

Related Procedure



Delete Command

Removes the selected program item from the group it's in or removes the selected group and its 
contents from Program Manager.
When you delete individual items or groups of items, you remove only the startup instructions 
represented by the icons, but the actual program files remain on your hard disk.

Related Procedures



Procedures
Deleting Groups
Deleting Items from a Group



Properties Command

Changes certain elements of the selected group or program item.
If you select a group, you can change its description (label).
If you select a program item, you can change its description (label), command line, and icon. By 

changing the item's pathname, you can use a different version of a program in a group or change the 
document that opens when you start the application.

Related Procedures



Procedures
Changing Group Descriptions
Changing Item Properties



Run Command

Starts an application (and opens a document if you wish).
In the Run dialog box, you type the command line that locates and starts an application (and opens a 
document for that application if you want). If the pathname for the application is not in the PATH= 
statement of your AUTOEXEC.BAT file, or if the application is not in the current directory, you must 
include it in the command line.
For example, to open Microsoft Word located in the \PCWORD directory, you would type this in the 
Command Line box:

\pcword\word.exe
Related Procedure



Exit Windows Command

Exits Program Manager and ends your Windows session.
You can save the appearance of the Program Manager workspace by selecting Save Changes. That 
way, the next time you start Windows, your desktop will look exactly as it did the last time you saw it. 
Selecting Save Changes also saves any settings you specified from the Options menu.

Related Procedure



Auto Arrange Command

Automatically arranges the program item icons when you resize a group window.
This command is in effect when you see a check mark next to its name on the menu. If you choose it 
again, you remove the check mark and disable the command.

Related Procedure



Minimize on Use Command

Minimizes Program Manager to an icon automatically whenever you start an application.
This command clears your desktop for the application, while keeping Program Manager easily 
accessible. Then, when you want to use Program Manager again, you double-click its icon to restore it 
to a window.
The command is in effect when you see a check mark next to it. If you choose it again, you remove the 
check mark and turn off the command.

Related Procedure



Cascade Command

Arranges and resizes group windows so that each title bar shows.
This command is useful when so many group windows are open that you have trouble finding the group 
you want.
You might want to choose the Auto Arrange command before choosing Cascade so that the icons are 
evenly distributed for the new window sizes.

Related Procedure



Tile Command

Arranges and resizes group windows so that they all fit in the application workspace, with the workspace
equally divided among them.
This command is useful when you want to see all the open group windows at the same time.
You might want to choose the Auto Arrange command before choosing Tile so that the icons are evenly 
distributed for the new window sizes.

Related Procedure



Arrange Icons Command

Redistributes program item icons and group icons to fit evenly in the open window.
When you add or remove program items or resize a group window, the contents sometimes need to be 
rearranged to be more readily visible. Also, when you change the size of the Program Manager window 
or add group icons, you will probably want to redistribute them to make them visible.
To arrange program item icons, you must select the group that contains them before you use this 
command. To arrange group icons, you must select a group icon before you choose Arrange.

Related Procedure



Group Names

Selects a group window.
The names of all the existing groups are listed at the bottom of the Window menu. You can choose a 
name from this list to make its window active or to restore its group icon to a window. Choosing from this
list is helpful when you have enough groups that it's difficult to see them all in your Program Manager 
workspace.

Related Procedure
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Opening Group Windows
Before you can choose a program item, you must open its group window.

To open a group window:
Double-click the group icon.

Or choose the group name from the Window menu. The names for all your groups are listed at the 
bottom of the Window menu.

Related Procedure
Keyboard Procedure



Minimizing Group Windows
You can minimize a group window, but you cannot close a group window. If you choose Close from the 
Control menu (an action that closes any other document window), Program Manager minimizes the 
group window.

To minimize a group window:
Click the Minimize button.

Or select the group's Control menu. Then choose Minimize.
Related Procedure
Keyboard Procedure



Arranging Group Windows
With the Cascade and Tile commands, you can arrange all the group windows so that part of each 
window is visible.

To arrange group windows:
Choose Cascade or Tile from the Window menu.

Click        to see how Cascade and Tile work.
Any other group window you open after cascading or tiling will overlap the rearranged windows. To 
include the new window among the rearranged windows, choose Tile or Cascade again.

Related Concept
Keyboard Procedure



cascade

tile



Arranging Icons
You can drag icons to new locations or you can let Program Manager arrange them for you.

To arrange group icons:
1 Select a group icon.
2 Choose Arrange Icons from the Window menu.

The group icons line up evenly spaced across the bottom of the Program Manager window.

To arrange program item icons:
1 Select the group window containing the program items you want to arrange.
2 Choose Arrange Icons from the Window menu.

Program Manager rearranges the program icons for the group you selected. If all the icons do not fit, 
a scroll bar appears. Each time you resize a window, you can use this procedure to arrange the icons.

To arrange program item icons automatically:
Choose Auto Arrange from the Options menu.

Program Manager automatically arranges the program item icons every time you resize a group. A 
check mark appears next to Auto Arrange on the menu to let you know it is in effect.

Related Topics
Keyboard Procedure



Concept
Arrangement of Windows and Icons

Procedure
Changing the Spacing Between Icons



Switching Among Group Windows
Sometimes you will have a number of group windows open at the same time. You can quickly switch 
among them.

To switch among group windows:
Click the group window that you want to switch to.

Or choose the group's name from the Window menu.
Keyboard Procedure



Creating Groups
You can create new groups with Program Manager. These groups can help you organize the 
applications and documents you work with into units that make sense to you.

To create a new group:
1 Choose New from the File menu.
2 Select the Program Group option and click OK.

Click        for an example of the Program Group Properties dialog box.
3 Type a description of the group in the Description box.

This description names the group on your screen, so keep it short.
4 Click OK.

An empty group window appears.
Related Topics
Keyboard Procedure



Concept
New Groups

Procedure
Adding Items to a Group



Program Manager automatically creates a .GRP file for the new group, so you can leave the Group File 
box blank.



Deleting Groups
If you no longer need a group, you can remove it from Program Manager.

To delete a group:
1 Minimize the group to a group icon if the window is open.
2 Select the group icon.
3 Choose Delete from the File menu.
4 Choose Yes to confirm the deletion.

Remember, program item icons represent instructions for starting your applications. Deleting them 
does not remove any application or document files from your hard disk.

Related Concept
Keyboard Procedure



Changing Group Descriptions
You can change the description of a group at any time, without changing its contents. The description 
names the group icon and also appears in the title bar of the group window.

To change the description of a group:
1 Minimize the group window if it is open.
2 Select the group icon.
3 Choose Properties from the File menu.
4 Type a new description in the Description box.
5 Click OK.

Related Concept
Keyboard Procedure



Adding Items to a Group
You can add program items for applications and for documents to your Program Manager groups.
Including more than 40 program items in a group is not recommended.

To add a program item to a group:
1 Select the group window or group icon for the new item.
2 Choose New from the File menu.
3 Select Program Item and click OK.
4 Type a name for the program item icon in the Description box.

This description is optional. If you leave it blank, Program Manager names the icon for you with a 
suitable name. The name will appear beneath the icon in the group window.

5 Type the name of the program file in the Command Line box. (Include the extension and complete 
pathname for the file, if necessary.)
If you don't know the filename, use the Browse button to locate it.
Click        to see a sample Command Line entry for an application.

6 If you want to open a document when the application starts, type a space after the program's filename
and type the filename of the document. (Include the extension and complete pathname for the file, if 
necessary.)
If you don't know the filename, use the Browse button to locate it.
Click        to see a sample Command Line entry for a document.

7 If you want to use a different icon from the one Program Manager automatically assigns, choose 
Change Icon (the Select Icon dialog box appears). Choose View Next to select the icon you want and 
then click OK.

8 Click OK.
Related Topics
Keyboard Procedure



Concept
Group Contents

Procedure
Copying and Moving Program Items



example
To add a Microsoft Excel program item from a directory named C:\EXCEL, you would type:

c:\excel\excel.exe
You don't need to type the entire pathname if the location of the program file is included in the PATH= 
statement of your AUTOEXEC.BAT file or if the program file is in the current directory.



example
To add an Excel spreadsheet named 91BUDGET.XLS stored in C:\ADMIN\FY9, you would type:

c:\excel\excel.exe    c:\admin\fy91\91budget.xls
If the document is in the same directory as the application, you don't have to repeat the pathname. For 
example, to include a spreadsheet located in the C:\EXCEL path, you would type:

c:\excel\excel.exe    house.xls



Copying and Moving Program Items
In addition to adding new items, you can duplicate existing items and move items from one Program 
Manager group to another.

To copy a program item:
1 Open the group window that contains the program item you want to copy.

Or open both group windows if you want to control the item's position in the destination group's 
window.

2 Hold down CTRL and drag the program item icon to the destination group's icon or window.
3 Release the mouse button and the CTRL key when the icon is on the destination group's icon or inside

the destination group's window.
Or release the mouse button and the CTRL key when the icon is still in the source group's window to 
repeat the program item in the same group.

To move a program item to another group:
1 Open the group window that contains the program item you want to move.
2 Drag the program item icon to the destination group's icon or window.
3 Release the mouse button when the icon is on top of the destination group's window or icon.

Related Topics
Keyboard Procedure



Concept
Group Contents

Procedure
Adding Items to a Group Using File Manager



Adding Items to a Group Using File Manager
You can add program items to Program Manager groups by dragging applications and associated 
documents from File Manager directory windows.

To add a program item using File Manager:
1 Position the group icon or resize the group window so that there's room for the File Manager window 

next to it.
2 Start File Manager and resize the window to fit in the space you allowed.    

3 Open the directory window that contains the program file or document file you want to add to 
Program Manager.
4 Select the program file or the document file and drag it into Program Manager.

As you drag the file, the mouse pointer turns into a black-and-white replica of the file's icon.
5 Drop the icon for the program or document into the Program Manager group window (or onto the 

group icon) by releasing the mouse button.
Click        to see an example.

This procedure has no keyboard equivalent.
Related Topics



Concept
Group Contents

Procedures
Adding Items to a Group
Opening Directory Windows



hint

You can use the Tile command in Task List to automatically resize and arrange the windows for File 
Manager and Program Manager. Make sure no other applications are open as windows if you use this 
method. Double-click anywhere on the desktop (or press CTRL+ESC) to open Task List.





Deleting Items from Groups
When you delete a program item from a group, you remove the program item icon from the group 
window in Program Manager. The program file remains on your hard disk.

To delete a program item from a group:
1 Open the group window that contains the item you want to delete.
2 Select the program item icon.
3 Choose Delete from the File menu.
4 Choose Yes to confirm the deletion.

Related Topics
Keyboard Procedure



Concept
Group Contents

Procedure
Adding Items to a Group



Changing Item Properties
You can change the description, program filename, document filename, or icon for any program item.

To change the properties of a program item:
1 Select the program item icon.
2 Choose Properties from the File menu.
3 Make the desired changes.
4 Click OK.
Click        to see an example of the Properties dialog box and the options you can change.

Related Concept
Keyboard Procedure





Starting Applications from Groups
To start an application from a group:
1 Open the Program Manager window and open the group window that contains the application's 

program item icon.
2 Double-click the icon.

Or select the program item icon and choose Open from the File menu.
Related Topics
Keyboard Procedure



Concept
Ways to Start Applications

Procedure
Starting Applications with the Run Command



Starting Applications with the Run Command
To start an application with the Run command:
1 Choose Run from the File menu in Program Manager.
2 Type the program filename, including the pathname and the extension if there is one.

Or type a space and the document filename (including the pathname) after the program name if you 
want to open a document at the same time you start the application.

3 Select the Run Minimized check box if you want the application to shrink to an icon as soon as it 
starts.

4 Click OK.
Related Topics
Keyboard Procedure



Concept
Ways to Start Applications

Procedure
Starting Applications from Groups



Starting a Non-Windows Application from the DOS Prompt
In addition to running non-Windows applications from Program Manager, you can also run them directly 
from MS-DOS. That way, you can type in MS-DOS commands just as you would if you were not running 
Windows.

To start the DOS Prompt and start a non-Windows application:
1 Double-click the DOS Prompt icon in Program Manager's Main Group.
2 Type the MS-DOS command to start your application.
3 To return to Windows without exiting the application, press ALT+TAB.

Or, close the application and then type exit and press ENTER to exit the DOS Prompt and return to 
Windows.

Related Topics
Keyboard Procedure



Concept
Ways to Start Applications

Procedure
Starting Applications from Groups



Automatically Minimizing Program Manager
You can set Program Manager to shrink to an icon whenever you start an application. That places the 
Program Manager icon at the bottom edge of the desktop, making it easy to find when you want to 
switch back to Program Manager.

To minimize Program Manager whenever you start an application:
Choose Minimize on Use from the Options menu.
Keyboard Procedure



Returning to Program Manager
To start another application from Program Manager or end your session in Windows, you must first 
return to Program Manager.

You can return to Program Manager in one of these ways:
If the Program Manager window is visible, click it.
If the Program Manager icon is visible, double-click it.
If Program Manager is not visible, double-click on the desktop (or press CTRL+ESC) to open Task 

List, and choose Program Manager from the list of running applications.
Keyboard Procedure



Exiting Program Manager
Even when you run other applications, Program Manager remains running in the background. You exit 
Program Manager only when you are ready to exit Windows.

To exit Program Manager (and Windows):
1 Close all applications except Program Manager.
2 Choose Exit from the File menu.

Windows displays a dialog box, asking if you're sure you want to end your Windows session.
3 Select the Save Changes option to save the changes you made in Program Manager.

Click        to see an example of the Save Changes check box.
NOTE: Don't confuse this option with the Save Settings check box in File Manager.

4 Click OK.
Related Topics
Keyboard Procedure



Concept
When You Exit Program Manager

Procedures
Returning to Program Manager
Quitting File Manager



Save Changes saves the arrangement of group windows, group icons, and program item icons. The 
commands you selected from the Options menu will still be selected the next time you start Windows.





To Press

Move among items within a group 
window

arrow keys

Move among group windows and icons CTRL+F6 or 
CTRL+TAB

Start the highlighted program ENTER

Close the active group window CTRL+F4

Exit Windows ALT+F4
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Returning to Program Manager
Exiting Program Manager (and Windows)



Keyboard: Opening Group Windows
To open a group window:

Press CTRL+F6 (or CTRL+TAB) until the group icon is selected. Then press ENTER.
Or press ALT and then W to open the Window menu. Then press the number representing the group 
name you want.

Related Procedure
Mouse Procedure



Keyboard: Minimizing Group Windows
To minimize a group window:
1 Select the group window.
2 Press ALT and then HYPHEN (-) to open the group's Control menu.
3 Press N.

Related Procedure
Mouse Procedure



Keyboard: Arranging Group Windows
To arrange group windows:

Choose Cascade (SHIFT+F5) or Tile (SHIFT+F4).
Related Concept
Mouse Procedure



Keyboard: Arranging Icons
To arrange group icons:
1 Press CTRL+F6 (or CRTL+TAB) repeatedly until you select a group icon.
2 Press ALT and then HYPHEN (-) to open the group icon's Control menu.
3 Press M.
4 Use the ARROW   keys   to move the icon to a new location.
5 Press ENTER.

To arrange group icons automatically:
1 Press CTRL+F6 (or CRTL+TAB) repeatedly until you select a group icon.
2 Press ALT and then W.
3 Press A.

To arrange program item icons:
1 Press CTRL+F6 (or CTRL+TAB) repeatedly until you select the group window that contains the icons you 

want to arrange.
Or skip this step if you've just resized a window and want to arrange the icons.

2 Press ALT and then W.
3 Press A.

To arrange program item icons automatically:
1 Press ALT and then O.
2 Press A.
Program Manager automatically arranges the program item icons every time you resize a group. A 
check mark appears next to Auto Arrange on the menu to let you know it is in effect.

Related Topics
Mouse Procedure



Concept
Arrangement of Windows and Icons

Procedure
Changing the Spacing Between Icons



Keyboard: Switching Among Group Windows
To switch among group windows:

Press ALT and then W. Then type the number from the Window menu that represents the group 
you want.

Or press CTRL+F6 (or CTRL+TAB) until the group window is selected.
Mouse Procedure



Keyboard: Creating Groups
To create a new group:
1 Press ALT and then F.
2 Press N.
3 Press the ARROW keys to select the Program Group option and press ENTER.
4 Type a description of the group in the Description box.
5 Press ENTER.

Related Topics
Mouse Procedure



Concept
New Groups

Procedure
Adding Items to a Group



Keyboard: Deleting Groups
To delete a group:
1 Press CTRL+F6 (or CTRL+TAB) until you select the icon for the group you want to delete.

NOTE: If the group is open in a window, minimize it.
2 Press ALT and then F.
3 Press D.
4 Press Y to confirm the deletion.

Related Concept
Mouse Procedure



Keyboard: Changing Group Descriptions
To change the description of a group:
1 Press CTRL+F6 (or CTRL+TAB) until you select the icon for the group whose description you want to 

change.
NOTE: If the group is open in a window, minimize it.

2 Press ALT and then F.
3 Press P.
4 Type a new description in the Description box.
5 Press ENTER.

Related Concept
Mouse Procedure



Keyboard: Adding Items to a Group
To add a program item and a document to a group:
1 Press CTRL+F6 (or CTRL+TAB) repeatedly until you select the group icon or group window.
2 Press ALT and then F.
3 Press N.
4 Press the ARROW keys to select the Program Item option and press ENTER.
5 Type a description of the program item in the Description box.
6 Press TAB and type the name of the program file in the Command Line box, including the extension 

and complete pathname required to locate the file, if necessary.
Or press ALT+B and select the program filename. Then press ENTER.

7 Type a space after the program's filename and then type the name of the document if you want to 
include a document with the program item.

8 Press ALT+I if you want to select a different icon; then press ALT+N repeatedly to reach the icon you 
want and press ENTER.

9 Press ENTER.
Related Topics
Mouse Procedure



Concept
Group Contents

Procedure
Copying and Moving Program Items



Keyboard: Copying and Moving Program Items
To copy or move a program item to another group:
1 Press CTRL+F6 (or CTRL+TAB) until you select the group and then press ENTER to open the group 

window that contains the program item you want to copy.
2 Press the ARROW   keys   to select the program item's icon.
3 Press ALT and then F.
4 Press C to copy.

Or press M to move.
5 Type the name of the destination group.

Or press the DOWN ARROW key until you find the name.
6 Press ENTER.

Related Topics
Mouse Procedure



Concept
Group Contents

Procedure
Adding Items to a Group Using File Manager



Keyboard: Deleting Items from Groups
To delete a program item from a group:
1 Open or select the group window that contains the icon you want to delete.
2 Press the ARROW   keys   to select the program item icon.
3 Press ALT and then F.
4 Press D.
5 Press Y to confirm the deletion.

Related Topics
Mouse Procedure



Concept
Group Contents

Procedure
Adding Items to a Group



Keyboard: Changing Item Properties
To change the properties of a program item:
1 Press the ARROW   keys   to select the program item icon.
2 Press ALT and then F.
3 Press P.
4 Make the desired changes.
5 Press ENTER.

Related Concept
Mouse Procedure



Keyboard: Starting Applications from Groups
To start an application from a group:
1 Open or select the group window that contains the program item icon for the application you want to 

start.
2 Press the ARROW   keys   to select the program item icon.
3 Press ENTER.

Related Topics
Mouse Procedure



Concept
Ways to Start Applications

Procedure
Starting Applications with the Run Command



Keyboard: Starting Applications with the Run Command
To start an application with the Run command:
1 Press ALT and then F.
2 Press R.
3 Type the pathname of the program file, including the extension if there is one.

Or type a space and the document pathname after the program name to open a document at the 
same time you start the application.

4 Press TAB and then press the SPACEBAR to select Run Minimized if you want the application to shrink 
to an icon as soon as it starts.

5 Press ENTER.
Related Topics
Mouse Procedure



Concept
Ways to Start Applications

Procedure
Starting Applications from Groups



Keyboard: Starting a Non-Windows Application from the DOS Prompt
To start the DOS Prompt and start a non-Windows application:
1 Press the ARROW   keys   to select the DOS Prompt icon in the Program Manager Main Group.
2 Press ENTER.
3 Type the appropriate MS-DOS command.
4 Type exit and press ENTER to exit the DOS Prompt.

Or leave MS-DOS running and switch to Windows.
Related Topics
Mouse Procedure



Concept
Ways to Start Applications

Procedures
Starting Applications from Groups
Switching Among Application Windows



Keyboard: Automatically Minimizing Program Manager
To minimize Program Manager whenever you start an application:
1 Press ALT and then O.
2 Press M.

Mouse Procedure



Keyboard: Returning to Program Manager
To return to Program Manager:

Press ALT+ESC (or ALT+TAB) until you select the Program Manager window or icon.
Or press CTRL+ESC to display Task List, press the ARROW keys to choose Program Manager from the 
list of running applications, and press ENTER.

Mouse Procedure



Keyboard: Exiting Program Manager
To exit Program Manager (and Windows):
1 Close all applications except Program Manager.
2 Press ALT and then F.
3 Press X.
4 Press TAB to move to Save Changes and press the SPACEBAR to select or clear its check box.
5 Press ENTER.

Related Topics
Mouse Procedure



Concept
When You Exit Program Manager

Procedure
Returning to Program Manager







Program Manager
Your base of operations in Windows. It is both an application starter and an organizational tool. From 
Program Manager you can start applications by double-clicking icons. You can also arrange your 
applications and documents into groupings.



application Control-menu



title bar          
Contains the title of the application running in the window, in this case Program Manager.

Drag the title bar to move the window.



Minimize button          
Click the Minimize button to shrink the Program Manager window to an icon.



Maximize button          
Click the Maximize button to enlarge the Program Manager window to its maximum size.



File menu



Options menu



Window menu



Help menu



menu bar          
Contains the names of all the Program Manager menus.

Click a menu name to display commands.



document Control-menu



group window title bar          
Contains the title of the open group window.

Drag the title bar to move the window.



Minimize button          
Click the Minimize button to shrink the group window to an icon.



Maximize button          
Click the Maximize button to enlarge the group window to its maximum size.



program item icon          

Represents an application or a document.
Double-click a program item icon to start an application or open a document.



group window          

Displays the program items in a group.
You can create groups and organize your applications to match the way you work. You can change the 
contents of a group by adding or deleting program items.



group icon          

Represents a group.
Double-click a group icon to open it.



window border          
The outside edge of a window.

Drag the window border to change the size of the window.



application window
The main window for an application, in this case the Program Manager window. The Program Manager 
application window contains group windows.



application icon          

Represents a running application. An application icon appears after you minimize an application.
Double-click an application icon to restore it to a window.



desktop
The background on which windows, icons, and dialog boxes appear.

Double-click anywhere on the desktop to start Task List.







A
386 enhanced mode
active
active printer
animation
application
application icon
application window
arrow keys
associate
AUTOEXEC.BAT



B
<< button
>> button
Back button
base-level synthesizer
batch file
baud rate
bitmap
branch
browse
byte



C
cascading menu complementary color
CD-ROM compound device
channel CONFIG.SYS
check box Contents button
choose Control menu
Clipboard Control-menu box
close conventional memory
collapse cutout
command
command button
command line



D
data bits Directory Tree window
default button directory window
default printer disk-drive icon
desktop display box
desktop pattern document
destination directory document file
device contention document window
device driver DOS
dialog box drag
directory path drop-down list box
Directory Tree



E
error-checking
expand
expanded memory
extended memory
extended synthesizer
extension



F
file
file information line
flow control
font
font size
format
full-screen application



G
General MIDI Mode standard
group
group icon
group window



H
History button
hotspot
hue
HyperGuide button bar



I
icon
insertion point
International MIDI Association



J
No defined terms.



K
keymaps
keyword
kilobyte



L
list box
local printer
local queue
luminosity



M
maximize MIDI Mapper
Maximize button MIDI sequencer
Media Control Interface MIDI Manufacturer's Association (MMA)
memory minimize
menu Minimize button
menu bar movie file
menu command MSCDEX
menu name multimedia extensions
menu title Multimedia PC
MIDI multitasking
MIDI file



N
network printer
network queue
network server
non-Windows application



O
open
option button



P
parity print option
palette printer-driver file
patch printer font
patchmaps printer queue information line
pathname program file
picture elements program information file (PIF)
pixels program item
playlist program item icon
pointer
port



Q
No defined terms.



R
RGB components
read-only
real mode
Restore button
root directory



S
sample serial port
saturation shortcut key
scaled font size shrink
screen font simple device
screen saver solid color
scroll arrow source directory
scroll bar spin box
scroll box standard mode
Search button status bar
select stop bits
selection cursor synthesizer



T
Task List
text box
text file
title
title bar
topic
track



U
Up button



V
vector font
virtual memory
volume label



W
waveform
WAVE format
wildcard characters
window
window border
Windows application
wrap



X
No defined terms.



Y
No defined terms.



Z
No defined terms.



386 enhanced mode
Provides access to the virtual memory capabilities of the Intel 80386 processor. With virtual memory 
capabilities, Windows applications can use more memory than is physically available. Enhanced mode 
also allows for multitasking of non-Windows applications.



active
Describes the selected window or icon that you are currently working with. Windows always applies the 
next keystroke or command you choose to the active window. If a window is active, it appears in front of 
all other windows on the desktop, and its title bar changes color to differentiate it visually from other 
windows. If an icon is made active, its Control menu appears.
Inactive is the opposite of active and describes windows or icons on the desktop that are not selected.



active printer
An installed printer that has been assigned to a printer port using Setup or Control Panel. More than one
printer can be set up to work on a single port, but only one can be active, since only one printer can be 
physically connected to the port at a time.
An inactive printer is an installed printer that is not currently connected to the printer port.



animation
The display of a series of graphic images, simulating motion. You can play animation files (for example, 
files with the.MMM extension) with the Media Player accessory. Animations are also called movies.



application
A computer program used for a particular kind of work, such as word processing. This term is often used
interchangeably with "program."



application icon          

An icon that represents an application that is running.



application window
The main window for an application. It contains the application's menu bar and main workspace. An 
application window may contain multiple document windows.



arrow keys          

The four arrow keys on your computer keyboard. These keys move the cursor or pointer on your screen 
to locations you choose. Each arrow key moves the cursor or pointer in the direction of the arrow on the 
key. Each arrow key is named for the direction in which arrow points: UP ARROW, DOWN ARROW, LEFT 
ARROW, and RIGHT ARROW.



associate
To assign files that have the same extension to a program. When you choose a file with the specified 
extension, the associated application runs with the file loaded.



AUTOEXEC.BAT
Batch file that lists MS-DOS commands. MS-DOS automatically carries out the commands in your 
AUTOEXEC.BAT file when you turn on your computer. The file is located in the root directory of your first
hard disk, which is usually drive C.
Typically, an AUTOEXEC.BAT file starts memory-resident utilities such as a network and sets up 
environment variables that are used later by applications. In addition, your AUTOEXEC.BAT file might 
set your MS-DOS prompt or start pop-up programs such as Borland's SideKick.



<< button          

Displays the previous topic in a series of topics, until you reach the first topic in the series. Then the 
button is dimmed. Use this button when you want to backtrack through topics the way they are 
organized in HyperGuide.



>> button          

Displays the next topic in a series of topics, until you reach the last topic in the series. Then the button is
dimmed. Use this button to move from topic to topic in the recommended order.



Back button          

Displays the last topic you viewed. HyperGuide moves back one topic at a time, in the order in which 
you viewed them.



base-level synthesizer
One of the two types of synthesizers accommodated by Windows.
MIDI files authored for Windows include two versions of a song: one version for base-level synthesizers 
and another version for extended synthesizers. The distinctions between base-level and extended 
synthesizers are based on the number of instruments and notes the synthesizer can play.



batch file
A file that runs a sequence, or "batch," of commands when you type its filename. All filenames of batch 
files end with the extension .BAT, even though you don't have to type this extension to run the batch file.



baud rate
Signalling speed measured by the number of signals per second.



bitmap          

An image stored as an array of bits.



branch          

A segment of the Directory Tree, representing a directory and any subdirectories it contains.



browse
To look through files and directories. In some dialog boxes, the Browse button shows a list of files and 
directories from which you can choose.



byte
The amount of memory space (normally 8 bits) that a computer needs to represent a single character or 
word.



cascading menu          

A menu that opens from a command on another menu.



CD-ROM
Compact Disc-Read Only Memory. An optical data-storage technology that allows large quantities of 
data (such as animations, images, music, and sound) to be stored on a compact disc similar to discs 
used by the music industry.



channel
MIDI uses channels to send messages to individual devices within a MIDI setup. There are 16 MIDI 
channel numbers. Devices in a MIDI setup can be directed to respond only to messages marked with a 
channel number specific to the device.



check box           

A small square box that appears in dialog boxes and can be selected or cleared. When the check box is 
selected, an X appears in the box.



choose
To use key combinations or your mouse to carry out a command in Windows. You often choose a 
command after you have selected an item or made it active.



Clipboard          

A temporary storage area in memory, used to transfer information. You can cut or copy information onto 
the Clipboard and then paste it into another document or application.



close
To reduce a document window or application window to an icon or, in some cases, to remove it from the 
desktop. You close a window by double-clicking the Control-menu box or choosing the Close command 
from the Control menu. When closing an application window, you can choose to save or abandon 
changes to the current document before you close it.



collapse
To hide a level of directory information in the Directory Tree window. When you first start File Manager, 
all directories but the root directory are collapsed.



command          

A word or phrase, usually found in a menu, that you choose to carry out an action.



command button          

A button in a dialog box that carries out or cancels the selected action. Two common command buttons 
are OK and Cancel. The button that carries out the action will often have a label that describes it (for 
example, Open, Create, Install). Another dialog box appears when you choose a command followed by 
ellipses.



command line
Information given to MS-DOS that specifies a command and all the pertinent information to carry it out. 
For example, to start Windows, you type win at the MS-DOS prompt.



complementary color
The color exactly opposite a color on the RGB color wheel. For example, the complementary color of 
blue is yellow.



compound device
Devices, such as the waveform audio driver, that have an associated file and require a filename 
specification when opened.



CONFIG.SYS
A file that defines device drivers and specifies your MS-DOS configuration. For example, a typical 
CONFIG.SYS file might specify the location of the MS-DOS file COMMAND.COM, define an extended 
memory manager, and specify how many files an application can have open at once. MS-DOS runs the 
commands in the CONFIG.SYS file each time you turn on your computer. Your CONFIG.SYS file is 
located in the root directory of your first hard disk, which is usually drive C.



Contents button          

Displays the HyperGuide contents.



Control menu          

The menu in the upper-left corner of a window. The Control menu appears on every application that runs
in a window and on some non-Windows applications. Document windows, icons, and some dialog boxes
also have Control menus.
Control menu commands move, change the size of, and close windows. You can also switch to Task List
by using the Control menu. For non-Windows applications, Control menu commands transfer 
information and perform other functions, depending on the application.



Control-menu box
The box located in the upper-left corner of a window. Clicking the Control-menu box opens the Control 
menu for the window.



conventional memory
The first 640K of memory that MS-DOS uses to run applications. Most computers have at least 256K of 
conventional memory and can accommodate up to 640K of conventional memory.



cutout          
A portion of a Paintbrush drawing you select with the Scissors or Pick tool.



data bits
The bits in each package of data sent between two computers during telecommunication. Most 
characters are transmitted in 7 or 8 data bits.



default button          

The command button in some dialog boxes that is automatically selected or chosen by Windows as the 
most logical or safest choice. The default button has a bold border, indicating that it will be chosen if you 
press ENTER. You can override a default button by choosing Cancel or another command button.



default printer
The printer that Windows applications automatically use when you choose the Print command. You can 
have only one default printer, which must also be the active printer on the port. The printer you use most 
often should be made the default printer.



desktop
The background of your screen, on which windows, icons, and dialog boxes appear.



desktop pattern
A geometric pattern that appears across your desktop. You can design your own pattern or choose one 
of the patterns provided by Windows.



destination directory
The directory to which you intend to copy or move one or more files.



device contention
When several applications simultaneously request use of a peripheral device, such as a printer or 
modem.
Windows automatically handles device contention when all the applications are Windows applications. 
When one of the applications is a non-Windows application, however, the conflict is handled according 
to the options you select in the 386 Enhanced dialog box. This dialog box appears when you choose the 
386 Enhanced icon in Control Panel.



device driver
Tells Windows how to control a piece of hardware. Using Control Panel, you can install device drivers for
your:

Display (monitor)
Keyboard
Mouse
Network



dialog box          

A rectangular box that either requests or provides information. Many dialog boxes present options that 
you must choose from before Windows can carry out a command. Some dialog boxes present warnings 
or explain why a command can't be completed.



directory path          

The directions to a directory or file within your system.
In the illustration, C:\ART stands for the ART directory on drive C. Any commands you use affect the files
and subdirectories in this directory.
When you want to specify a file, make sure the filename follows the directory path.



Directory Tree          

A graphic display of a disk's directory structure. The directories on the disk are shown as branching from
the disk's root directory.



Directory Tree window          

A File Manager window that shows the complete branching structure of the selected disk drive.



directory window          

A File Manager window that lists the contents of a specific directory. The directory window shows all the 
files and subdirectories contained in the directory.



disk-drive icon          

An icon in the Directory Tree window of File Manager that represents a disk drive on your system. 
Different icons depict floppy disk drives, hard disk drives, RAM drives, CD-ROM drives, and network disk
drives.



display box          

A display box is not an option, but a type of text box that shows an example of another option you have 
selected, in this case a sample of the 10 pt, underlined, Helvetica font.



document
Whatever you create with an application, including information you enter, edit, view, or save. A document
can be a business report, a spreadsheet, a picture, and so on.



document file          

Files that are associated with an application. You can start an application and open the associated file by
choosing a document file icon.



document window          

A window inside an application window. Each document window contains a single document or other 
data file. There can be more than one document window inside an application window.



DOS
Disk Operating System, typically known as MS-DOS (Microsoft) or PC-DOS (IBM). This is the underlying
software that must exist for your PC to operate.



drag
A mouse move. You drag a Windows element by pointing to it, holding down the mouse button, and 
sliding the mouse from one spot on the surface of your desk to another and releasing the mouse button.



drop-down list box
A list box that opens and closes in dialog boxes.
Before you open a drop-down list box, it looks like this:

After the list box is open, it looks like this:

NOTE: When the list is longer than the box, scroll bars are provided.



error checking
A method for validating transmissions.



expand
To show hidden directory levels in the Directory Tree. With File Manager, you can expand a single 
directory level, one branch of the Directory Tree, or all branches at once.



expanded memory
Memory in addition to conventional memory that is available to applications. It is allocated in 16K blocks.
Windows makes use of expanded memory only if the /r switch is used at startup. Windows running in 
386 enhanced mode simulates expanded memory for the applications that need it. Windows running in 
standard mode or 386 enhanced mode allows applications to use expanded memory, but does not use 
expanded memory itself in managing applications.



extended memory
Memory in addition to conventional memory that is not readily accessible to MS-DOS or MS-DOS 
applications. Extended memory cannot be used on 8086 and 8088 computers. Windows running in 
standard mode or 386 enhanced mode uses extended memory to manage and run applications.



extended synthesizer
One of the two types of synthesizers accommodated by Windows.
MIDI files authored for Windows include two versions of a song: one version for base-level synthesizers 
and another version for extended synthesizers. The distinctions between base-level and extended 
synthesizers are based on the number of instruments and notes the synthesizer can play.



extension
Part of a file or directory name that appears after a period and provides additional information. It usually 
indicates the type of file or directory. For example, program files have default extensions of .COM 
or .EXE .
Many applications include a default extension automatically when you save a file the first time. For 
example, Notepad adds a .TXT extension to all filenames unless you specify otherwise.



file
A document or application that has been given a name. All documents are stored as files in Wiindows.



file information line          

Information specific to each file in a print queue. The information can include these details:
The file's position in the queue or a printer icon if the file is printing.
The title of the print job assigned by the application (if your network software supports this).
What percentage of the file has printed so far.
The size of the file in kilobytes (if the Print File Size command on the View menu is selected).
The time and date you sent the file to Print Manager (if the Time/Date Sent command on the View

menu is selected).
If you are connected to a network printer, the printer queue information line shows the network server 
connection. Any detailed information the network can provide appears in the message box at the upper-
right corner of the Print Manager window. Networks can provide varying degrees of detailed information.



flow control
The method for controlling the flow of information.



font          
A graphic design applied to all numerals, symbols, and characters in the alphabet. A font usually comes 
in different sizes and provides different styles, such as bold, italic, and underlining for emphasizing text.



font size
The height of a printed character, measured in points. One inch equals 72 points. For example, 12-point 
Helv is 12 points high.

The font and font size you use determine the amount of text that fits on one page. 



format
(1) The appearance of text on the pages of a document. (2) To prepare a disk so it can hold information. 
Formatting a disk erases all information that was previously on it.



full-screen application
A non-Windows application that uses the entire screen--rather than a window--to run in the Windows 
environment.



General MIDI Mode standard
A MIDI specification controlled by the MIDI Manufacturers Association (MMA). The purpose of this 
specification is to enable MIDI file authors to create files that sound the same across a variety of 
different synthesizers.



group
A collection of applications within Program Manager. Grouping your applications makes them easier to 
find.



group icon          

A group window you have reduced to an icon in Program Manager.



group window          

A window that displays the items in a group within Program Manager. These items can be applications, 
files associated with applications, or a combination of both.



History button        

Displays a list of the HyperGuide topics you have viewed. Use this button to revisit any of the last 40 
HyperGuide topics you have viewed. The most recent topic appears first.



hotspot
Text, graphics, or parts of graphics that provide links to other HyperGuide topics or more information 
about the current topic.
Whether text or graphics, the pointer changes to the shape of a hand whenever it is over a hotspot. If 
you click a hotspot that is linked to another topic, that topic will appear in the HyperGuide window. If the 
hotspot is linked to more information, HyperGuide displays the information in a popup window on top of 
the HyperGuide window.



hue
The position of a color along the color spectrum.



HyperGuide button bar          
Contains the HyperGuide buttons you use to move among topics and contents screens. It is located 
near the top of the HyperGuide window.



icon          

A graphic representation of a disk drive, directory, group, application, document, and so on. You can 
restore an application icon to a window when you want to use the application.



insertion point          
The place where text will be inserted when you type.The insertion point usually appears as a flashing 
vertical bar in an application's window or in a dialog box. The text you type appears to the left of the 
insertion point, which moves to the right as you type.



International MIDI Association (IMA)
The non-profit MIDI organization that circulates information about the MIDI specification.



keymaps
Percussion instruments are key-based--each note plays a different percussion instrument. Keymaps 
translate MIDI key values to ensure the proper percussion instruments are used to play MIDI files. All 
MIDI files for Windows are authored using standard key assignments based on the General MIDI Mode 
standard.



keyword
Words in the HyperGuide Search dialog box that are associated with topics. Each application's 
documentation has its own keyword list, including the glossary words in HyperGuide. You select from the
list of keywords or type a keyword to see the list of topics associated with that keyword.



kilobyte
The measurement used for the size of a computer's memory, where 1 kilobyte (K) = 1,024 bytes.



list box          

A box within a dialog box that lists available choices--for example, the list of all available files in a 
directory. If all the choices don't fit in the box, there will be a vertical scroll bar to the right of the list box. 
In some list boxes, you can select more than one item.



local printer
A printer that is directly connected to your printer by a cable.



local queue          

Lists the files that you directed to any active printer connected to your computer. The computer and 
printers are connected locally by a cable.
When Print Manager starts printing on a local printer, its icon appears at the bottom of your screen. If 
you restore the icon to a window, you see the print queue for any active printer connected to your 
computer. You can use the Print Manager window to check the status of files in the print queue or to 
interrupt or cancel a print job.



luminosity
The brightness of the color on a scale from black to white.



maximize
To enlarge a window to its maximum size by using the Maximize button or the Maximize command.



Maximize button          

The small button at the upper-right corner of a window that contains an Up arrow. Mouse users can click
the Maximize button to enlarge a window to its maximum size. Keyboard users can use the Maximize 
command on the Control menu.



Media Control Interface (MCI)
A standard control interface for multimedia devices and files. MCI allows a multimedia application to 
easily control a variety of multimedia devices and files.



memory
The space in a computer where information is stored while you are working with it. Most PCs have a 
small amount of read-only memory (ROM), containing the built-in programs that start the operation of 
the computer when it is turned on, and a large amount of random-access memory (RAM) for users' 
programs and data.



menu          

A list of available commands in an application window. Menu names appear in the menu bar near the 
top of the window. The Control menu, represented by the Control-menu box at the left end of the title 
bar, is common to all Windows applications. You use a command on a menu by selecting the menu 
name, then choosing the command you want.



menu bar          
The horizontal bar containing the names of an application's menus. It appears just under the title bar.



menu command          

A word or phrase in a menu that you choose to carry out an action, such as copying a file.



menu name
The name for a particular menu that appears in the menu bar and opens a menu when you choose it.



menu title
A word or phrase in the menu bar that identifies a group of commands. Selecting the menu title causes 
the title to be highlighted and its menu of commands to appear below it.



MIDI
Musical Instrument Digital Interface. MIDI sets a communications standard for transferring data between
musical instruments and associated devices.



MIDI file
A file format for storing MIDI songs. In Windows, MIDI files have a .MID filename extension. 



MIDI Mapper
A Control Panel option that lets you create and edit MIDI setup maps. Windows uses these maps to 
translate and redirect MIDI data. 



MIDI Sequencer
Software that creates or plays songs stored as MIDI files. When a sequencer plays MIDI files, it sends 
MIDI data from the file to a MIDI synthesizer that produces the sounds. Windows provides a MIDI 
sequencer to play MIDI files.



MIDI Manufacturer's Association (MMA)
A collective organization composed of MIDI instrument manufacturers and MIDI software companies. 
The MMA works with the MIDI Standards Committee to maintain the MIDI specification. 



minimize
To reduce a window to an icon using the Minimize button or the Minimize command. The document or 
application remains open (or running), and can be the active application or document.



Minimize button          

The small button at the upper-right corner of a window that contains a Down arrow. Mouse users can 
click the Minimize button to reduce a window to an icon. Keyboard users can use the Minimize 
command on the Control menu.



movie file
A multimedia data file (for example, a file with the .MMM extension). You can play movie files with the 
Media Player accessory. Movie files are also called animations. 



MSCDEX
Microsoft Compact Disc Extensions. MSCDEX is software that makes CD-ROM drives appear to DOS 
as network drives. You must have MSCDEX installed on your computer for the CD-ROM drive to work. 



multimedia extensions
Additional features added to Windows version 3.0 that enable your computer to run animations, play 
sound and MIDI files, and display high-quality images. 



Multimedia PC
Multimedia personal computer. A multimedia computer satisfies a minimum set of hardware/software 
requirements necessary for multimedia computing. The requirements include:

An 80286/386/486 microprocessor running at 10MHz or faster
2MB or more of RAM
30MB or larger hard disk
VGA display
A digital audio subsystem
A CD-ROM drive
Systems software compatible with Microsoft Windows version 3.0 with multimedia extensions



multitasking
The ability of a single computer to perform several tasks simultaneously.
Multitasking makes it possible to print one document while editing another, or to perform lengthy 
computations while you work on something else.



network printer
A printer that is accessible to your computer only through a network.



network queue
Lists the files on the network server if you are using a network printer.



network server
A computer on a network that provides a particular service to other computers. For example, a disk 
server manages a large file server, and a print server manages a printer.



non-Windows application
An application that was not designed to run in Windows. Generally, non-Windows applications do not 
conform to Windows user-interface standards.



open
To display the contents of a directory or file in a window, or to enlarge an icon to a window.



option button           

A small round button that appears in a dialog box and is used to select an option. Within a group of 
related option buttons, you can select only one button.



palette
Defines the colors used in a bitmap image. Every device independent bitmap (DIB) has an associated 
color palette. 



parity
The method of detecting errors in data transmission.



patch
A specific sound created by a synthesizer. A synthesizer plays notes using sounds defined as patches.



patchmaps
A patch is a specific sound created by a synthesizer. A synthesizer plays notes using sounds defined as 
patches. Patchmaps translate MIDI patch changes to ensure the proper instruments are used to play 
MIDI files. All MIDI files for Windows are authored using standard patch assignments based on the 
General MIDI Mode standard.



pathname
The directions to a directory or file within your system. For example, C:\WINDOWS3\APPTS\JUNE.CAL 
is the pathname of the JUNE.CAL file in the APPTS subdirectory in the WINDOWS3 directory on drive 
C.



picture elements
The smallest graphics unit on the screen. Also known as pels.



pixels
The smallest graphic units on the screen. Also known as picture elements (pels).



playlist
A list of compact disc titles and tracks that determines the order in which the tracks on the disc are 
played. Playlists are only used in Music Box.
Use the Program button to assign or edit titles, and to change the playlist.



pointer          
In Windows, the shape of the pointer indicates its function.

For selecting Windows items, scrolling, resizing windows, 
and moving windows and dialog boxes with your mouse. 
This is the pointer you will see most often.

For choosing a HyperGuide hotspot.

For selecting text with your mouse.

For changing the size of a window with your mouse.

For changing the location or size of a window with your 
keyboard.

For indicating the application is processing your request.

port
A connection on a computer where you plug in a cable that carries data to a device.
LPT ports are parallel ports. COM ports are serial ports. EPT is a port used for certain printers, such as 
the IBM Personal Pageprinter. You can use the EPT port only if you have installed a special card in your 
computer.
Multimedia PCs also have a port for a MIDI sequencer.



print options
Printer-specific settings such as page orientation--portrait or landscape--or the manner in which paper 
feeds through the printer. These options vary from printer to printer.



printer-driver file
A file that gives Windows important information about how to control your printer, including details about 
printer features and the printing interface, descriptions of fonts (such as sizes and styles), character 
translations, and control sequences the printer uses to achieve various formats. Windows has printer-
driver files for most commonly used printers.



printer font
A series of dots connected by lines that can be scaled to different sizes. Another name for printer fonts is
vector (or stroke) fonts. Plotters typically use vector fonts.



printer queue information line          

Indicates the following:
The name of the printer.
Where the printer connects to your computer.
The current status of the printer.



program file          

A file that contains information that controls an application. In File Manager, each program file is 
represented by an icon. You can start the application by choosing the icon. Filenames for program files 
can have these extensions: .EXE, .COM, .PIF, and .BAT.



program information file (PIF)
A file that provides important information that Windows needs to run a non-Windows application. PIFs 
contain information such as the name of the file, a startup directory, whether the program writes directly 
to the screen or to memory, and multitasking options for applications running in 386 enhanced mode.



program item          

A program file or associated document represented by an icon in Program Manager. The program item 
provides the instructions Windows needs to start an application and open a document (if specified) when
you choose the icon.



program item icon          

An icon representing an application you can start or an associated document you can open from a group
in Program Manager. The program item provides the instructions Windows needs to start an application 
and open a document (if specified) when you choose the icon.



RGB components
The amount of each of the three primary colors--red, green, and blue--present in a color. Every color and
pattern is made by varying the three primary colors. This is true even in monochrome (black and white) 
mode. For instance, white is made by mixing together 255 parts of red, 255 parts of green, and 255 
parts of blue. Black, on the other hand, is 0 red, 0 green, and 0 blue.



read-only
Describes a file or CD-ROM disc that can only be opened and read. You cannot edit a read-only file or 
CD-ROM disc and save your changes.



real mode
An operating mode that Windows runs in to provide maximum compatibility with versions of Windows 
applications released prior to Windows version 3.0. Real mode is the only mode available for computers 
with less than 1 MB of extended memory.



Restore button          

The small button at the upper-right corner of a window that contains both an Up arrow and a Down 
arrow. The Restore button appears only after you have enlarged a window to its maximum size. Mouse 
users can click the Restore button to return the window to its previous size. Keyboard users can use the 
Restore command on the Control menu.



root directory
The main directory on a disk. The root directory is created at the first level when you format a disk. The 
symbol used to indicate the root directory of a disk is the backslash (\). For example, the root directory 
for drive C is noted as C:\.



sample
A piece of waveform data represented by a single numerical value. You convert sound into digital form 
by taking samples of the sound at specific time intervals and converting them to numeric values.



saturation
The purity of a hue, moving from gray to the pure color.



scaled font size
A font size that approximates a specified font size for use on the screen. Windows scales larger font 
sizes when a size that is available for the printer is not available for the screen. Scaled fonts may look 
slightly different from unscaled fonts. When you choose a smaller font size that is available for the printer
but not for the screen, Windows substitutes the correct size from a precision-drawn font that resembles 
the selected font as closely as possible.



screen font
A font that duplicates a printer font on your screen.

If you choose a printer font that does not have a corresponding screen font, Windows substitutes a 
screen font that closely resembles the printer font. The substitute font duplicates the line lengths and 
page breaks of the font you selected.
When you purchase extra fonts from a printer or font manufacturer, ask about the availability of screen 
fonts to match.



screen saver
An image or pattern that is shown on your computer screen during periods of inactivity. Screen savers 
hide information currently on the screen; by changing patterns they can also save wear on the 
electronics in the display.



scroll arrow          

An arrow on either end of a scroll bar that is used to scroll through the contents of a window or list box. 
Clicking a scroll arrow moves the contents one line. Holding down a scroll arrow scrolls the contents 
continuously.
Scroll arrows also control the playing of media in some applications, such as Media Player and Sound 
Recorder.



scroll bar          
A bar that appears at the right and/or bottom edge of a window whose contents aren't completely visible.
Each scroll bar contains two scroll arrows and a scroll box, which allow you to scroll within the window or
list box.
A scroll bar is also used to control playing of media in some applications, such as Media Player and 
Sound Recorder.



scroll box          

The square or rectangular box within a scroll bar that indicates your relative position within a document 
or list box. Mouse users can drag the scroll box up or down quickly through long documents.
A scroll box is also used to control playing of media in some applications, such as Media Player and 
Sound Recorder.



Search button          

Displays the keywords you can use to search for topics. Use this button to look for topics related to a 
keyword.



select
To mark an item by highlighting it with key combinations or with a mouse. Selecting does not initiate an 
action. After selecting an item, you choose the action that affects or involves the item. For example, you 
can select text and then choose the Copy command to copy the text onto the Clipboard.



selection cursor          
The marking device that shows where you are in a window, menu, or dialog box and what you have 
selected. The selection cursor appears as a dotted box around the text in a dialog box option.



serial ports
Ports used by your system, named COM1, COM2, and so on. Serial ports are typically used for 
connecting modems, mouse devices, and some kinds of printers.



shortcut key          

A key or key combination, available for some commands, that you can press to carry out a command 
without first selecting a menu. The shortcut key for a command is listed to the right of the command 
name on the menu.



shrink
To reduce a window to an icon using the Minimize button or the Minimize command. The document or 
application remains open (or running), and can be the active application or document.



simple device
Devices, such as audio compact-disc players, that don't have an associated file and can be opened 
without a filename specification.



solid color
A color directly supported by your display.



source directory
The directory containing the file or files you intend to copy or move.



spin box          

A spin box shows one item in a range of possible choices. Clicking the Up or Down arrow to the right of 
the entry lets you "spin" through the available choices until your choice appears in the display rectangle.



standard mode
The normal operating mode for running Windows. This mode provides access to extended memory. In 
standard mode, you can also switch among non-Windows applications.



status bar          
A line of information located at the top or bottom of a window. For example, in a directory window the 
status bar tells how many files are selected, how much disk space they occupy, and the total number of 
files in the directory. In the Directory Tree window, the status bar shows the number of bytes available on
the disk and the total disk capacity. Not all windows have a status bar.



stop bits
The timing unit between characters.
Stop bits are not actually bits; they determine the time between transmitted characters.



synthesizer
An electronic instrument able to make music and sounds by creating its own audio waveforms and 
sending them out to an audio system. A synthesizer can play back MIDI files.



Task List
A window that shows all the applications you have running so you can switch among them. You can 
open the Task List window by choosing Switch To from the Control Menu or by pressing CTRL+ESC.



text box          

A box within a dialog box where you type the information needed to carry out a command. When the 
dialog box appears, the text box may be blank or may contain text.



text file
A file containing only plain text, numbers or symbols. The text in a text file is uniform and does not 
contain any formatting, such as bold, underline, or different fonts and font sizes. A text file usually 
consists of characters coded from the ASCII character set. 
The advantage of a text file is that it can be transferred to almost any text editor or word processor. Also,
MS-DOS and Windows use text files, such as AUTOEXEC.BAT, CONFIG.SYS, and WIN.INI.



title
Another name for a software application written to run on a Multimedia PC. 



title bar          
The horizontal bar at the top of a window that contains the title of the window or dialog box. On many 
windows, the title bar also contains the Control-menu box and Maximize and Minimize buttons.



topic
The level in the HyperGuide hierarchy at which you see information in the main window. This information
can be in the form of a Quick Look graphic, an explanation of a command, a conceptual overview, a 
procedure, or a table of keys. Information in pop-up windows and contents screens are not considered 
topics.



track
A sequence of sound on a CD disc, which usually corresponds to a song.



Up button          

Moves up one level in the HyperGuide hierarchy.



vector fonts
A series of dots connected by lines that can be scaled to different sizes.



virtual memory
A memory management system used by Windows running in 386 enhanced mode, which allows 
Windows to behave as if there were more memory than is actually present in the sytem. Virtual memory 
equals the amount of free RAM plus the amount of disk space allocated to a swap file that Windows 
uses to simulate additional RAM.



volume label          
The name you give a disk by using the Label command. Disk labels are optional. You see this 
information in File Manager only if you assigned a label to your disk. You can change or add a disk label 
through File Manager.



WAVE format
Microsoft's format for digitized waveform files. These files have a .WAV extension.



waveform
A sound waveform displays variances in air pressure over time. An audio signal waveform displays 
variances in voltage over time.



wildcard characters
Two MS-DOS characters you can substitute for all or part of a file or directory name when you want to 
find similarly-named files or want one command to affect a number of files or directories.
An asterisk (*) substitutes for all characters. A question mark (?) substitutes for a single character.
For example, this entry covers all files with a .DOC extension in the current directory:

*.DOC
And this entry covers everything named with FY, three other characters, and the extension .90:

FY???.90



window
A rectangular area on your screen in which you view an application or document. You can open, close, 
and move windows, and change the size of most windows. You can open several windows on the 
desktop at the same time and you can shrink windows to icons or enlarge them to fill the entire desktop.



window border          
The outside edge of a window. You can lengthen or shorten each border. You can also change the width 
of the border with Control Panel's Desktop command.



Windows application
An application that was designed for Windows and will not run without Windows. All Windows 
applications follow the same conventions for arrangement of menus, style of dialog boxes, use of the 
keyboard and mouse, and so on.



wrap
The automatic movement of the insertion point from the end of one line to the beginning of the next line 
as you type. When text wraps, you do not need to press ENTER at the end of each line in a paragraph.






